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MSG revision history

Revision Publication date Description

A November 2009 The part number has been updated to 593138-001 for the 90-W HP Smart AC
adapter for use in all countries and regions except India. The information was
updated in the following locations: Miscellaneous parts on page 33 and Sequential
part number listing on page 35.

B September 2010 Updated spare part number 482959-001 (Audio/ExpressCard assembly) to indicate
the spare kit does not include the cable. The information was updated in the following
locations: Computer major components on page 22, Sequential part number listing
on page 35, and Audio/ExpressCard assembly on page 97.

Updated spare part number 487432-001 (Cable Kit) to indicate the kit includes the
Audio/ExpressCard cable. The information was updated in the following locations:
Computer major components on page 22 and Cable Kit on page 31.

Removed spare part number 593138-001 (90-W HP Smart AC adapter for use in all
countries and regions except India). The information was removed from the following
locations: Miscellaneous parts on page 33 and Sequential part number listing
on page 35.

Updated the spare part numbers for the memory. The information was updated in the
following locations: Computer major components on page 22, Sequential part
number listing on page 35, Primary memory module on page 67, and Expansion
memory module on page 62.

Added spare part numbers for new display panels. The information was added in the
following locations: Computer major components on page 22, Sequential part
number listing on page 35, and Display assembly on page 85.

Added spare part numbers for new LED display bezels. The information was added in
the following locations: Computer major components on page 22, Sequential part
number listing on page 35, and Display assembly on page 85.

Added spare part numbers for new system boards for Russia and the People's
Republic of China. The information was added in the following locations: Computer
major components on page 22, Sequential part number listing on page 35, and
System board on page 100.

Added spare part numbers for new WLAN modules. The information was added in
the following locations: Computer major components on page 22, Sequential part
number listing on page 35, and WLAN module on page 70.

Added spare part numbers for new keyboards. The information was added in the
following locations: Computer major components on page 22, Sequential part
number listing on page 35, and Keyboard on page 65.

Added spare part numbers for new AC adapters. The information was added in the
following locations: Computer major components on page 22 and Sequential part
number listing on page 35.

Added a spare part number for a new capacitative board with cable. The information
was added in the following locations: Computer major components on page 22 and
Sequential part number listing on page 35.
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B (continued) September 2010 Added a spare part number for a new docking station. The information was added in
the following locations: Computer major components on page 22 and Sequential
part number listing on page 35.

Updated the spare part number for the upgrade bay cradle from 502322-001 to
613682-001. The information was updated in the following locations: Computer
major components on page 22 and Sequential part number listing on page 35.

Updated the spare part numbers for various processors. The information was updated
in the following locations: Computer major components on page 22, Sequential part
number listing on page 35, and Processor on page 83.

Added a spare part number for a new top cover without fingerprint reader. The
information was added in the following locations: Computer major components
on page 22, Sequential part number listing on page 35, and Top cover
on page 90.

Updated and added spare part numbers for various new hard drives. The information
was updated and added in the following locations: Computer major components
on page 22, Sequential part number listing on page 35, Mass storage devices
on page 32, and Hard drive on page 56.

Added spare part numbers for new batteries. The information was added in the
following locations: Computer major components on page 22, Sequential part
number listing on page 35, and Battery on page 50.

Updated the hard drive specifications in the following location: Hard drive
specifications on page 111.
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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

Product Name HP EliteBook 6930p Notebook PC √ √

Processors Intel® Core™ 2 Duo processors

 ● T9900 3.06-GHz processor, 6-MB
L2 cache, 1066-MHz front side
bus (FSB)

√ √

 ● T9800 2.93-GHz processor, 6-MB
L2 cache, 1066-MHz FSB

√ √

 ● T9600 2.80-GHz processor, 6-MB
L2 cache, 1066-MHz  FSB

√ √

 ● T9550 2.66-GHz processor, 6-MB
L2 cache, 1066-MHz FSB, 35W

√ √

 ● T9400 2.53-GHz processor, 6-MB
L2 cache, 1066-MHz FSB, 35W

√ √

 ● P9600 2.66-GHz processor, 6-MB
L2 cache, 1066-MHz FSB, 25W

√ √

 ● P9500 2.53-GHz processor, 6-MB
L2 cache, 1066-MHz FSB, 25W

√ √

 ● P8800 2.66-GHz processor, 3-MB
L2 cache, 1066-MHz FSB

√ √

 ● P8700 2.53-GHz processor, 3-MB
L2 cache, 1066-MHz FSB

√ √

 ● P8600 2.40-GHz processor, 3-MB
L2 cache, 1066-MHz FSB

√ √

 ● P8400 2.26-GHz processor, 3-MB
L2 cache, 1066-MHz FSB

√ √

Chipset Northbridge: Intel GM45 with up to
1067 FSB with iAMT support

√  

 Northbridge: Intel PM45 with up to
1067 FSB with iAMT support

 √

 Southbridge: Intel ICH9M enhanced √ √
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Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

Graphics ATI M82-SCE Mobility Radeon HD
3450 discrete graphics subsystem
memory with 128 MB GDDR3
(operating at 700 MHz) or 256 MB
GDDR3 (operating at 700 MHz)

√  

 Mobile Intel GMA X4500 HD Universal
Memory Architecture (UMA) graphics
subsystem integrated with shared video
memory (dynamically allocated), up
to 384 MB

 √

Panels All display assemblies include 3
wireless local area network (WLAN)
antennae

√ √

 Supports HP Panel Protection System √ √

 Supports HP privacy filter √ √

 Supports the following display assemblies:

 ● 14.1-inch WXGA LED √ √

 ● 14.1-inch WXGA+ √ √

 ● 14.1-inch WXGA √ √

Memory 2 customer-accessible/upgradable
memory module slots

√ √

 Supports dual-channel memory √ √

 Supports up to 8 GB of system RAM √ √

 PC2-6400, 800-MHz, DDR2 √ √
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Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

 Supports the following configurations in
all countries and regions except Brazil:

● 8192-MB total system memory
(4096 × 2, dual-channel)

● 4096-MB total system memory
(2048 × 2, dual-channel)

● 4096-MB total system memory
(4096 × 1)

● 3072-MB total system memory
(2048 + 1024, dual-channel)

● 2048-MB total system memory
(1024 × 2)

● 2048-MB total system memory
(2048 × 1)

● 1024-MB total system memory
(512 × 2, dual-channel)

● 1024-MB total system memory
(1024 × 1)

√ √

 Supports the following configurations
only in Brazil:

● 4096-MB total system memory
(2048 × 2, dual-channel)

● 2048-MB total system memory
(1024 × 2, dual-channel)

● 2048-MB total system memory
(2048 × 1)

● 1024-MB total system memory
(512 × 2, dual-channel)

● 1024-MB total system memory
(1024 × 1)

√ √

Hard drives Supports 9.5-mm (2.5-inch) hard drives √ √

 Customer-accessible √ √

 Serial ATA √ √

 Supports Disk Sanitizer √ √

 Supports full disk encryption √ √

 Supports HP 3D DriveGuard √ √
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Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

 Supports RAID 0 (striping) and
RAID 1 (mirror)

√ √

 Supports the following drives:

● 320-GB, 7200-rpm hard drive

● 250-GB, 7200-rpm hard drive

● 160-GB, 7200-rpm hard drive

● 120-GB, 7200-rpm hard drive

● 128-GB, solid-state drive

● 80-GB solid-state drive

√ √

Upgrade bay Fixed (removal of 1 screw required) √ √

 Customer-accessible √ √

 Serial ATA √ √

 12.7-mm tray load √ √

 Supports weight saver option √ √

 Supports the following optical drives:

● DVD±RW and CD-RW SuperMulti
Double-Layer Combo Drive
with LightScribe

● DVD±RW and CD-RW SuperMulti
Double-Layer Combo Drive

● DVD/CD-RW Combo Drive

● DVD-ROM Drive

√ √

 Supports the following hard drives
(requires the upgrade bay cradle):

● 250-GB, 5400-rpm

● 160-GB, 7200-rpm

√ √

Audio/video HD audio √ √

 Integrated dual array microphones (2) √ √

 Stereo speakers (2) √ √

 Integrated 2-megapixel webcamera √ √

Modem 56K V.92 1.5-inch data/fax modem √ √

 Support for no-modem option √ √
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Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

Ethernet Intel 82567LM 10/100/1000 Ethernet,
with iAMT Intel 82567LM Gigabit
network connection

√ √

 S4/S5 wake on LAN: DC - no √ √

 S4/S5 wake on LAN: AC - yes √ √

Wireless Integrated WLAN options by way of wireless module:

 3 WLAN antennae built into
display assembly

√ √

 Support for no-WLAN option √ √

 Support for the following WLAN
formats:

● Broadcom 4322 802.11a/b/g/n

● Broadcom 4311AG 802.11a/b/g

● Broadcom BCM4312 802.11b/g

● Intel Wi-Fi Link 5300 802.11a/b/
g/n

● Intel Wi-Fi Link 5100 802.11a/b/
g/n

● Intel Wi-Fi Link 5100 802.11b/g

√ √

 Integrated WWAN options by way of wireless module:

 2 WWAN antennae built into
display assembly

√ √

 Subscriber identity module (SIM) security √ √

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Support for no-WPAN option √ √

 Broadcom Bluetooth 2.0+EDR √ √

External media
cards

One ExpressCard/54 slot √ √

 SD card reader supporting Secure
Digital (SD) Memory Card and
MultiMediaCard (MMC)

√ √

Ports Audio-in (mono microphone) √ √

 Audio-out (stereo headphone) √ √

 Docking √ √
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Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

 Battery (system) √ √

 Battery (travel) √ √

 RJ-11 (modem) √ √

 RJ-45 (Ethernet, includes link and
activity lights)

√ √

 USB (3) √ √

 VGA (Dsub 15-pin) supporting 1600 ×
1200 external resolution at 75-GHz (hot
plug/unplug with auto-detect)

√ √

 1394a √ √

 3-pin HP Smart AC Adapter √ √

Keyboard/
pointing
devices

11.97-inch keyboard with embedded
numeric keypad

√ √

 Spill-resistant keyboard √ √

 Dura-Keys √ √

 Vertical scrolling, taps enabled as
default

√ √

 Dualpoint (pointing stick and TouchPad)
with 2 pointing stick buttons and 2
TouchPad buttons

√ √

Power
requirements

90-W HP Smart AC Adapter with
localized cable plug support (2-wire
plug with ground pin, supports 2-
pin DC connector)

√ √

 120-W HP Smart AC Adapter with
localized cable plug support (2-wire
plug with ground pin, supports 2-
pin DC connector)

√ √

 8-cell, 58-Wh Li-ion battery √ √

 6-cell, 55-Wh Li-ion battery √ √

 4-cell, 37-Wh Li-ion battery √ √

 Support for 12-cell Ultra
Capacity Battery

√ √

 Support for 8-cell Li-ion Extended
Life Battery

√ √

 HP Fast Charge Technology √ √
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Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

Security Supports Kensington security sock √ √

Infineon Trusted Platform Module
(TPM) v. 1.2

√ √

 TPM Enhanced Drive Lock √ √

 Fingerprint reader √ √

 Integrated smart card reader √ √

Operating
system

Preinstalled:

 Windows® Vista® Basic 32 with and
without Office Ready

√ √

 Windows Vista Business 32 with and
without Office Ready

√ √

 Windows Vista Ultimate with Office
Ready (in Canada and
the United States)

√ √

 Windows Vista Business with
Windows® XP Pro with and without
Office Ready

√ √

 Windows Vista Basic 32 with Office
Personal and Powerpoint (Japan)

√ √

 Windows Vista Basic 32 with Office Pro
2007 (Japan)

√ √

 Windows Vista Business 32 with Office
Personal and Powerpoint (Japan)

√ √

 Windows Vista Business 32 with Office
Pro 2007 (Japan)

√ √

 Windows Vista Business 32 with Office
Personal (Japan)

√ √

 Windows Vista Business with Windows
XP Pro and Office Personal with
Powerpoint (Japan)

√ √

 Windows Vista Business with Windows
XP Pro and Office Pro 2007 (Japan)

√ √

 Windows Vista Business with Windows
XP Pro with Office Personal (Japan)

√ √

 FreeDOS √ √

 Restore media:
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Category Description Computer models
equipped with discrete
graphics subsystem
memory

Computer models
equipped with Unified
Memory Architecture
(UMA) graphics
subsystem memory

 DRDVD Windows Vista √ √

 DRDVD Windows XP √ √

 Windows Vista Basic 32 √ √

 Windows Vista Business 32 √ √

 Windows Vista Business 64 √ √

 Windows Vista Ultimate √ √

 Windows XP Pro √ √

 Certified:

 Microsoft® WHQL √ √

 Novell √ √

 SuSE Linux √ √

 Web support:

 Windows Vista Enterprise 32 √ √

 Windows Vista Enterprise 64 √ √

 Windows XP Pro √ √

Serviceability Customer service replaceable (CSR) parts:

 AC adapter √ √

 Battery (system) √ √

 Expansion memory module √ √

 Hard drive √ √

 Keyboard √ √

 Optical drive √ √

 Primary memory module √ √

 SIM √ √

 WLAN module √ √

 WWAN module √ √
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2 External component identification

Top components
Display

Item Component Function

(1) Ambient light sensor Automatically adjusts the display brightness based on the
lighting conditions in your environment.

(2) Internal microphones (2) Record sound.

(3) HP Webcam Records video and captures still video.

(4) HP Webcam light On: The integrated camera is in use.

(5) Keyboard light Illuminates the keyboard in low-light conditions when the
keyboard light button is pressed.

(6) Keyboard light button Opens and turns on the keyboard light.
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Antennae

Item Component Description

(1) WWAN antennae (2)* Send and receive wireless signals to communicate with
wireless wide-area networks (WWAN).

(2) WLAN antennae (3)* Send and receive wireless signals to communicate with
wireless local area networks (WLAN).

*The antennae are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennae free from obstructions.
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Button, switches, and fingerprint reader

Item Component Function

(1) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down
the computer.

● When the computer is in the Sleep state, press the button
briefly to exit Sleep.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about your power settings, select Start >
Control Panel > System and Maintenance >
Power Options.

(2) Internal display switch Turns off the display if the display is closed while the power
is on.

(3) Info button Launches Info center, which enables you to open various
software solutions.

(4) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(5) Presentation button Starts the presentation feature.

(6) Volume mute button Mutes and restores speaker sound.
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Item Component Function

(7) Volume scroll zone Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume. You can
also press the left side of the volume slider to decrease
volume, or press the right side of the volume slider to increase
volume.

(8) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a
password logon.

Keys

Item Component Function

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Lights

Item Component Function

(1) Wireless lights (2)* ● On: An integrated wireless device, such as a wireless
local area network (WLAN) device, the HP Broadband
Wireless Module, and/or a Bluetooth® device, is on.

● Amber: All wireless devices are off.

(2) Power lights (2)† ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When the
battery reaches a critical battery level, the battery light
begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays off
until the battery reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive, and if present, the hard drive in the
upgrade bay.
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Item Component Function

(5) Caps lock light On: Caps lock is on.

(6) Num lock light On: Num lock is on or the embedded numeric keypad
is enabled.

(7) Volume mute light ● On: Computer sound is on.

● Amber: Computer sound is off.

(8) Volume down light Blinking: The volume scroll zone is being used to decrease
speaker volume.

(9) Volume up light Blinking: The volume scroll zone is being used to increase
speaker volume.

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open.
The wireless light on the front of the computer is visible whether the computer is open or closed.

†The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The
power light on the front of the computer is visible whether the computer is open or closed.

Pointing devices

Item Component Function

(1) Pointing stick Moves the pointer and selects or activates items on the screen.

(2) Left pointing stick button* Functions like the left button on an external mouse.

(3) TouchPad* Moves the pointer and selects or activates items on the screen.

(4) Left TouchPad button* Functions like the left button on an external mouse.

(5) Right pointing stick button* Functions like the right button on an external mouse.

(6) TouchPad scroll zone Scrolls up or down.
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Item Component Function

(7) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel >
Hardware and Sound > Mouse.
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Front components

Item Component Function

(1) Wireless light On: An integrated wireless device, such as a wireless local
area network (WLAN) device, the HP Broadband Wireless
Module, and/ or a Bluetooth device, is on. Amber: All
wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When the
battery reaches a critical battery level, the battery light
begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays off
until the battery reaches a low battery level.

(4) Drive light Blinking green: The hard drive or optical drive is being
accessed. Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(5) SD card reader Supports the Secure Digital (SD) Memory Card and
MultiMediaCard (MMC) optional digital card formats.

(6) Speakers (2) Produce sound.

(7) Display release button Opens the computer.

(8) Bluetooth compartment Contains a Bluetooth device.
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Rear components

Item Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent,
but it may not prevent the computer from being mishandled
or stolen.

(2) Power connector Connects an AC adapter.

(3) External monitor port Connects an external VGA monitor or projector.

Right-side components

Item Component Function

(1) Smart card reader Supports optional smart cards and Java™ cards.

(2) Upgrade bay Supports an optical drive or hard drive.

(3) USB port Connects an optional USB device.

(4) RJ-45 (network) jack Connects a network cable.

(5) RJ-11 (modem) jack Connects a modem cable.
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Left-side components

Item Component Function

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(2) USB ports (2) Connect optional USB devices.

(3) 1394 port Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(5) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television
audio.

(6) ExpressCard slot Supports optional ExpressCards.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Docking connector Connects an optional docking device.

(3) Vents (5) Enable airflow to cool internal components.

CAUTION: To prevent overheating, do not obstruct vents.
Use the computer only on a hard, flat surface. Do not allow
another hard surface, such as an adjoining optional printer, or
a soft surface, such as pillows or thick rugs or clothing, to
block airflow.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(4) Accessory battery connector Connects an optional accessory battery.

(5) Memory module compartment Contains the expansion memory module slot.

(6) Hard drive bay Holds the hard drive.

(7) WWAN module compartment Contains a WWAN module (select models only).

CAUTION: To prevent an unresponsive system and the
display of a warning message, replace the device with only a
WLAN module authorized for use in the computer by the
governmental agency that regulates wireless devices in your
country. If you replace the device and then receive a warning
message, remove the device to restore computer functionality,
and then contact technical support through Help and Support.
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Item Component Function

(8) Battery release latch Releases the battery from the battery bay.

(9) SIM slot (select models only) Contains a wireless subscriber identity module (SIM). The SIM
slot is located inside the battery bay.
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3 Illustrated parts catalog

Serial number location
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: Describes the duration of the warranty period for the computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer major components
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Item Description Spare part number

(1) 14.1-inch, AntiGlare display assemblies (include three WLAN antenna cables, two WWAN antenna
cables, and two microphones):

 WXGA LED display assembly with webcam (includes webcam cable) 487433-001

 WXGA LED display assembly without webcam 483202-001

 WXGA+ display assembly with webcam (includes webcam cable) 487435-001

 WXGA+ display assembly without webcam 483201-001

 WXGA display assembly with webcam (includes webcam cable) 487434-001

 WXGA display assembly without webcam 483200-001

 Display assembly internal components:

 Display bezels

 For use only with computer models equipped with non-LED displays and a webcam 488189-001

 For use only with computer models equipped with non-LED displays without a webcam 488190-001

 For use only with computer models equipped with LED displays and a webcam 518420-001

 For use only with computer models equipped with LED displays without a webcam 518421-001

 Webcam 486302-001

 Display panels  

 WXGA display panel 623154-001

 WXGA LED display panel 623155-001

 WXGA+ display panel 623156-001

 Display inverter 487431-001

 Display Hinge Kit (includes left and right hinges) 482967-001

 Display Cable Kit (includes display panel cable) 482966-001

 Logo Kit 500325-001

 Wireless Antenna Kit (includes 3 WLAN antenna transceivers and cables and 2
WWAN antenna transceivers and cables)

482969-001

(2) Switch cover (includes capacitative board and cable) 486307-001

 Capacitative board (includes cable; not illustrated) 487428-001

(3) Power button board (includes cable) 482964-001

(4a) Keyboards (include keyboard cable, keyboard shield, pointing stick, and pointing stick cable)

 For use in Belgium 483010-A41

 For use in Brazil 483010-201

 For use in the Czech Republic 483010-221

 For use in Denmark 483010-081
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Item Description Spare part number

 For use in Europe, the Middle East, and Africa 483010-021

 For use in France 483010-051

 For use in French Canada 483010-121

 For use in Germany 483010-041

 For use in Greece 483010-DJ1

 For use in Hungary 483010-211

 For use in Iceland 483010-DD1

 For use in Israel 483010-BB1

 For use in Italy 483010-061

 For use in Japan 483010-291

 For use in Latin America 483010-161

 For use in the Netherlands 483010-B31

 For use in Norway 483010-091

 For use in Portugal 483010-131

 For use in Russia 483010-251

 For use in Saudi Arabia 483010-171

 For use in Sweden and Finland 483010-B71

 For use in Slovakia 483010-231

 For use in Slovenia 483010-BA1

 For use in South Korea 483010-AD1

 For use in Spain 483010-071

 For use in Switzerland 483010-BG1

 For use in Taiwan 483010-AB1

 For use in Turkey 483010-141

 For use in the United Kingdom 483010-031

 For use in the United States 483010-001

(4b) Keyboard shield (included with keyboard spare part kit)

 Pointing stick rubber caps (not illustrated) 486565-001

(5) Fan 487436-001

(6) Heat sinks (include replacement thermal material)

 For use only with computer models with discrete graphics subsystem memory 483011-001

 For use only with computer models with UMA graphics subsystem memory 483012-001
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Item Description Spare part number

 Plastics Kit (see Plastics Kit on page 30 for more Plastics Kit spare
part information):

487429-001

(7a) ExpressCard slot bezel

(7b) Hard drive bay cover

(7c) Memory module compartment cover

(7d) Bluetooth module compartment cover

(7e) WWAN module compartment cover

 Cable Kit: 487432-001

(8a) Bluetooth module cable

(8b) Modem module cable (includes RJ-11 connector)

 Audio board cable (not illustrated)

(9) Intel Core 2 Duo processors (include replacement thermal material)

 T9900, 3.06-GHz (1066-MHz FSB, 6-MB L2 cache) 570434-001

 T9800, 2.93-GHz (1066-MHz FSB, 6-MB L2 cache) 507951-001

 T9600, 2.80-GHz (1066-MHz FSB, 6-MB L2 cache) 507955-002

 T9550, 2.66-GHz (1066-MHz FSB, 6-MB L2 cache, 35W) 507953-001

 T9400, 2.53-GHz (1066-MHz FSB, 6-MB L2 cache, 35W) 507956-002

 P9600, 2.66-GHz (1066-MHz FSB, 3-MB L2 cache, 25W) 507957-001

 P9500, 2.53-GHz (1066-MHz FSB, 6-MB L2 cache, 25W) 507958-001

 P8800, 2.66-GHz (1066-MHz FSB, 3-MB L2 cache) 570036-001

 P8700, 2.53-GHz (1066-MHz FSB, 3-MB L2 cache) 507960-001

 P8600, 2.40-GHz (1066-MHz FSB, 3-MB L2 cache) 507963-002

 P8400, 2.26-GHz (1066-MHz FSB, 3-MB L2 cache) 507964-002

(10) Primary memory modules (PC2-6400, 800-MHz, DDR2)

 4096-MB 598855-001

 2048-MB 598858-001

 1024-MB 598861-001

(11) Modem modules

NOTE: The modem module spare part kits do not include a modem module cable. The modem module cable is
included in the Cable Kit, spare part number 487432-001. See Cable Kit on page 31 for more Cable Kit spare
part information.

 For use in all countries and regions except Australia and New Zealand 461750-001

 For use only in Australia and New Zealand 461750-011

(12) WLAN modules
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Item Description Spare part number

 Intel Wi-Fi Link 5300 802.11a/b/g/n WLAN module for use in all
countries and regions

480986-001

 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all
countries and regions

480985-001

 Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all
countries and regions

482957-001

 Broadcom 4322 802.11a/b/g/n WLAN modules:

 ● For use in Antigua and Barbuda, Barbados, Belize, Canada,
the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

487330-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis,
St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

 Broadcom BCM4312 802.11b/g WLAN modules:

 ● For use in Antigua and Barbuda, Barbados, Belize, Canada,
the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

459263-001
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Item Description Spare part number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis,
St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

 Intel Wi-Fi Link 5100 802.11a/b/g/n 1x2 WLAN module with iAMT 4.0 support for
use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
Uruguay, the United States, Venezuela, and Vietnam

506678-001

 Intel Wi-Fi Link 5300 802.11a/b/g/n 3x3 WLAN module with iAMT 4.0 support for
use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
Uruguay, the United States, Venezuela, and Vietnam

506679-001

 Intel 802.11a/b/g WLAN module for use in Russia, Ukraine, and Pakistan 506680-001

(13) RTC battery 482963-001

(14) Top cover (includes smart card reader and TouchPad buttons)  

 With fingerprint reader 486303-001

 Without fingerprint reader 611810-001

(15) TouchPad (includes cable and TouchPad button board and cable) 486306-001

(16) Fingerprint reader board (includes cable) 486309-001
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Item Description Spare part number

(17) Audio/ExpressCard assembly (includes ExpressCard slot, cable, headphone and
microphone connectors, and SD card reader slot)

NOTE: The Audio/ExpressCard assembly spare part kit does not include an audio
cable. The Audio/ExpressCard assembly cable is included in the Cable Kit, spare part
number 487432-001. See Cable Kit on page 31 for more Cable Kit spare part
information.

482959-001

(18) Speaker 486308-001

(19) System boards (include replacement thermal material)

 For use in all countries and regions except for Russia and the People's Republic of
China

 

 ● For use only with computer models with discrete graphics subsystem memory
(includes 256 MB of graphics subsystem memory

486300-001

 ● For use only with computer models with discrete graphics subsystem memory
(includes 128 MB of graphics subsystem memory

486299-001

 ● For use only with computer models with UMA graphics subsystem memory 486301-001

 For use in only in Russia and the People's Republic of China  

 ● For use only with computer models with discrete graphics subsystem memory
(includes 256 MB of graphics subsystem memory

510352-001

 ● For use only with computer models with discrete graphics subsystem memory
(includes 128 MB of graphics subsystem memory

510351-001

 ● For use only with computer models with UMA graphics subsystem memory 510353-001

(20) Batteries

 8-cell, 58-Wh Li-ion battery for use only in Japan 534063-291

 6-cell, 62-Wh Li-ion battery for use only in Japan 534218-291

 6-cell, 55-Wh Li-ion battery 482962-001

 4-cell, 37-Wh Li-ion battery 482961-001

(21) Base enclosure 482960-001

 Rubber Kit (not illustrated, includes base enclosure rubber feet and rubber
screw covers)

482968-001

(22) Optical drives (include bezel and bracket)

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive 515874-001

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 483190-001

 DVD/CD-RW Combo Drive 483189-001

 DVD-ROM Drive 483191-001

 Upgrade bay device cradle 613682-001

(23) Hard drives (include bracket)

 320-GB, 7200-rpm 531969-001
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Item Description Spare part number

 250-GB, 7200-rpm 495059-001

 160-GB, 7200-rpm 483186-001

 120-GB, 7200-rpm 483184-001

 128-GB solid-state drive (not illustrated) 575554-001

 80-GB solid-state drive (not illustrated) 486304-001

(24) External memory modules (PC2-6400, 800-MHz, DDR2)

 4096-MB 598855-001

 2048-MB 598858-001

 1024-MB 598861-001

(25) Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module
cable. The Bluetooth module cable is included in the Cable Kit, spare part number
487432-001. See Cable Kit on page 31 for more Cable Kit spare part information.

483113-001

(26) HP un2400 Mobile Broadband WWAN module 483377-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 487429-001

(1) Hard drive bay cover (includes 2 captive screws, secured by C-clips)

(2) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(3) ExpressCard slot bezel

(4) WWAN module compartment cover (includes one captive screw, secured by a C-clip)

(5) Bluetooth module compartment cover (includes one captive screw, secured by a C-clip)
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Cable Kit

Item Description Spare part number

 Cable Kit: 487432-001

(1) Modem module cable (includes RJ-11 connector)

(2) Bluetooth module cable

 Audio/ExpressCard cable (not illustrated)
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Mass storage devices

Item Description Spare part number

(1) Hard drives (include bracket)

 320-GB, 7200-rpm 531969-001

 250-GB, 7200-rpm 495059-001

 160-GB, 7200-rpm 483186-001

 120-GB, 7200-rpm 483184-001

(2) Optical drives (include bezel and bracket)

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive 515874-001

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 483190-001

 DVD/CD-RW Combo Drive 483189-001

 DVD-ROM Drive 483191-001

(3) Solid-state drives  

 128-GB 575554-001

 80-GB 486304-001

 Upgrade bay device cradle (not illustrated) 613682-001
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Miscellaneous parts
Description Spare part number

Docking station 483203-001

AC adapters

Smart Adapter, 90-W PFC AC adapter for use only in India 535593-001

Smart Adapter, 90-W PFC, RC/V 3W 620656-001

Smart Adapter, 90-W PFC, RC/V EM 3W for use only in India 613160-001

Smart Adapter, 90-W PFC, RC/V 3W 613153-001

Smart Adapter, 90-W, for use only in India 463956-001

Smart Adapter, 120-W PFC, RC/V 3W 613154-001

Smart Adapter, 120-W PFC, 3P/RC 463953-001

Power cords:

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-201

For use in Europe, the Middle East, and Africa 490371-021

For use in Iceland 490371-BB1

For use in India 490371-D61

For use in Italy 490371-061

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom 490371-031

For use in the United States 490371-001
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Description Spare part number

Screw Kit

● Phillips PM3.0×4.0 screw

● Phillips PM2.5×11.0 captive screw

● Phillips PM2.5×10.0 captive screw

● Phillips PM2.5×9.0 captive screw

● Phillips PM2.5×7.0 screw

● Phillips PM2.5×4.0 screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.0×5.0 screw

● Phillips PM2.0×3.0 broad-head screw

● Phillips PM2.0×3.0 screw

● Torx T8M2.5×7.0 screw

486305-001

Travel battery 456946-001
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Sequential part number listing
Spare part
number

Description

456946-001 Travel battery

459263-001 Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands,
and the United States

459263-002 Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

461750-001 Modem module for use in all countries and regions except Australia and New Zealand

NOTE: The modem module spare part kits do not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 487432-001. See Cable Kit on page 31 for more
Cable Kit spare part information.

461750-011 Modem module for use only in Australia and New Zealand

NOTE: The modem module spare part kits do not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 487432-001. See Cable Kit on page 31 for more
Cable Kit spare part information.

463953-001 Smart Adapter, 120-W PFC, 3P/RC

463956-001 Smart Adapter, 90-W, for use only in India

480985-001 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions

480986-001 Intel Wi-Fi Link 5300 802.11a/b/g/n WLAN module for use in all countries and regions

482957-001 Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions

482959-001 Audio/ExpressCard assembly (includes ExpressCard slot, cable, headphone and microphone connectors,
and SD card reader slot)The Audio/ExpressCard assembly spare part kit does not include an audio
cable. The Audio/ExpressCard assembly cable is included in the Cable Kit, spare part number
487432-001. See Cable Kit on page 31 for more Cable Kit spare part information.
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Spare part
number

Description

482960-001 Base enclosure

482961-001 4-cell, 37-Wh Li-ion battery

482962-001 6-cell, 55-Wh Li-ion battery

482963-001 RTC battery

482964-001 Power button board (includes cable)

482966-001 Display Cable Kit (includes display panel cable)

482967-001 Display Hinge Kit (includes left and right hinges)

482968-001 Rubber Kit (includes base enclosure rubber feet, rubber screw covers, and display bezel rubber
screw covers)

482969-001 Wireless Antenna Kit (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)

483010-001 Keyboard for use in the United States (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

483010-021 Keyboard for use in Europe, the Middle East, and Africa (includes keyboard cable, keyboard shield,
pointing stick, and pointing stick cable)

483010-031 Keyboard for use in the United Kingdom (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

483010-041 Keyboard for use in Germany (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-051 Keyboard for use in France (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-061 Keyboard for use in Italy (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-071 Keyboard for use in Spain (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-081 Keyboard for use in Denmark (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-091 Keyboard for use in Norway (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-121 Keyboard for use in French Canada (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

483010-131 Keyboard for use in Portugal (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-141 Keyboard for use in Turkey (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-161 Keyboard for use in Latin America (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

483010-171 Keyboard for use in Saudi Arabia (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

36 Chapter 3   Illustrated parts catalog



Spare part
number

Description

483010-201 Keyboard for use in Brazil (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-211 Keyboard for use in Hungary (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-221 Keyboard for use in the Czech Republic (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

483010-231 Keyboard for use in Slovakia (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-251 Keyboard for use in Russia (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-281 Keyboard for use in Thailand (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-291 Keyboard for use in Japan (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-A41 Keyboard for use in Belgium (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-AB1 Keyboard for use in Taiwan (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-AD1 Keyboard for use in South Korea (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-BA1 Keyboard for use in the Slovenia (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-B31 Keyboard for use in the Netherlands (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

483010-B71 Keyboard for use in Sweden and Finland (includes keyboard cable, keyboard shield, pointing stick, and
pointing stick cable)

483010-BB1 Keyboard for use in Israel (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-BG1 Keyboard for use in Switzerland (includes keyboard cable, keyboard shield, pointing stick, and pointing
stick cable)

483010-DD1 Keyboard for use in Iceland (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483010-DJ1 Keyboard for use in Greece (includes keyboard cable, keyboard shield, pointing stick, and pointing stick
cable)

483011-001 Heat sink for use only with computer models with discrete graphics subsystem memory (includes
replacement thermal material)

483012-001 Heat sink for use only with computer models with UMA graphics subsystem memory (includes
replacement thermal material)
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Spare part
number

Description

483113-001 Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 487432-001. See Cable Kit on page 31
for more Cable Kit spare part information.

483184-001 120-GB, 7200-rpm hard drive (includes bracket)

483186-001 160-GB, 7200-rpm hard drive (includes bracket)

483189-001 DVD/CD-RW Combo Drive

483190-001 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

483191-001 DVD-ROM Drive

483200-001 14.1-inch, WXGA AntiGlare display assembly for use on computer models not equipped with a webcam
(includes three WLAN antenna cables, two WWAN antenna cables, and two microphones)

483201-001 14.1-inch, WXGA+ AntiGlare display assembly for use on computer models not equipped with a
webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two microphones)

483202-001 14.1-inch, WXGA AntiGlare LED display assembly for use on computer models not equipped with a
webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two microphones)

483203-001 Docking station

483377-001 HP un2400 Mobile Broadband WWAN module

486299-001 System board with 128 MB of discrete graphics subsystem memory for use in all countries and regions
except for Russia and the People's Republic of China (includes replacement thermal material)

486300-001 System board with 256 MB of discrete graphics subsystem memory for use in all countries and regions
except for Russia and the People's Republic of China (includes replacement thermal material)

486301-001 System board for use only with computer models with UMA graphics subsystem memory for use in all
countries and regions except for Russia and the People's Republic of China (includes replacement
thermal material)

486302-001 Webcam

486303-001 Top cover with fingerprint reader (includes TouchPad buttons)

486304-001 80-GB solid-state drive

486305-001 Screw Kit

486306-001 TouchPad (includes cable and TouchPad button board and cable)

486307-001 Switch cover (includes capacitative board and cable)

486308-001 Speaker

486309-001 Fingerprint reader board (includes cable)

486565-001 Pointing stick rubber caps

487330-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands,
and the United States
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487330-002 Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487428-001 Capacitative board (includes cable)

487429-001 Plastics Kit (see Plastics Kit on page 30 for more Plastics Kit spare part information)

487431-001 Display inverter

487432-001 Cable Kit (see Cable Kit on page 31 for more Cable Kit spare part information)

487433-001 14.1-inch, WXGA AntiGlare LED display assembly for use on computer models equipped with a webcam
(includes three WLAN antenna cables, two WWAN antenna cables, and two microphones)

487434-001 14.1-inch, WXGA AntiGlare display assembly for use on computer models equipped with a webcam
(includes three WLAN antenna cables, two WWAN antenna cables, and two microphones)

487435-001 14.1-inch, WXGA+ AntiGlare display assembly for use on computer models equipped with a webcam
(includes three WLAN antenna cables, two WWAN antenna cables, and two microphones)

487436-001 Fan

488189-001 Display bezel for use only with computer models equipped with non-LED displays and a webcam

488190-001 Display bezel for use only with computer models equipped with non-LED displays without a webcam

490371-001 Power cord for use in the United States

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom

490371-061 Power cord for use in Italy

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil
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490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Iceland

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

495059-001 250-GB, 7200-rpm hard drive (includes bracket)

500325-001 Logo Kit

502322-0001 Upgrade bay device cradle

506678-001 Intel Wi-Fi Link 5100 802.11a/b/g/n 1x2 WLAN module with iAMT 4.0 support for use in Antigua and
Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands,
Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti,
Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietnam

506679-001 Intel Wi-Fi Link 5300 802.11a/b/g/n 3x3 WLAN module with iAMT 4.0 support for use in Antigua and
Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands,
Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti,
Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietnam

506680-001 Intel 802.11a/b/g WLAN module for use in Russia, Ukraine, and Pakistan

507951-001 Intel Core 2 Duo T9800, 2.93-GHz processor (1066-MHz FSB, 6-MB L2 cache, includes replacement
thermal material)

507953-001 Intel Core 2 Duo T9550, 2.66-GHz processor (1066-MHz FSB, 6-MB L2 cache, 35W, includes
replacement thermal material)

507955-002 Intel Core 2 Duo T9600, 2.80-GHz processor (1066-MHz FSB, 6-MB L2 cache, includes replacement
thermal material)

507956-002 Intel Core 2 Duo T9400, 2.53-GHz processor (1066-MHz FSB, 6-MB L2 cache, 35W, includes
replacement thermal material)

507957-001 Intel Core 2 Duo P9600, 2.66-GHz processor (1066-MHz FSB, 3-MB L2 cache, 25W, includes
replacement thermal material)

507958-001 Intel Core 2 Duo P9500, 2.53-GHz processor (1066-MHz FSB, 6-MB L2 cache, 25W, includes
replacement thermal material)

507960-001 Intel Core 2 Duo P8700, 2.53-GHz processor (1066-MHz FSB, 3-MB L2 cache, includes replacement
thermal material)

507963-002 Intel Core 2 Duo P8600, 2.40-GHz processor (1066-MHz FSB, 3-MB L2 cache, includes replacement
thermal material)

507964-002 Intel Core 2 Duo P8400, 2.26-GHz processor (1066-MHz FSB, 3-MB L2 cache, includes replacement
thermal material)
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510351-001 System board with 128 MB of discrete graphics subsystem memory for use only in Russia and the
People's Republic of China (includes replacement thermal material)

510352-001 System board with 256 MB of discrete graphics subsystem memory for use only in Russia and the
People's Republic of China (includes replacement thermal material)

510353-001 System board for use only in computer models with UMA graphics subsystem memory for use only in
Russia and the People's Republic of China (includes replacement thermal material)

515874-001 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive

518420-001 Display bezel for use only with computer models equipped with LED displays that include a webcam

518421-001 Display bezel for use only with computer models equipped with LED displays without a webcam

531969-001 320-GB, 7200-rpm hard drive (includes bracket)

534063-291 8-cell, 58-Wh Li-ion battery for use only in Japan

534218-291 6-cell, 62-Wh Li-ion battery for use only in Japan

535593-001 Smart Adapter, 90-W PFC, for use only in India

570036-001 Intel Core 2 Duo P8800, 2.66-GHz processor (1066-MHz FSB, 3-MB L2 cache, includes replacement
thermal material)

570434-001 Intel Core 2 Duo T9900, 3.06-GHz processor (1066-MHz FSB, 6-MB L2 cache, includes replacement
thermal material)

575554-001 128-GB solid-state drive

598855-001 4096-MB memory module (PC2-6400, 800-MHz, DDR2)

598858-001 2048-MB memory module (PC2-6400, 800-MHz, DDR2)

598861-001 1024-MB memory module (PC2-6400, 800-MHz, DDR2)

611810-001 Top cover without fingerprint reader (includes TouchPad buttons)

613153-001 Smart Adapter, 90-W PFC, RC/V 3W

613154-001 Smart Adapter, 120-W PFC, RC/V 3W

613160-001 Smart Adapter, 90-W PFC, RC/V EM 3W for use only in India

613682-001 Upgrade bay device cradle

620656-001 Smart Adapter, 90-W PFC, RC/V 3W

623154-001 WXGA display panel

623155-001 WXGA LED display panel

623156-001 WXGA+ display panel
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 73).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 72 screws, in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: Describes the duration of the warranty period for the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 482968-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

8-cell, 58-Wh Li-ion battery for use only in Japan 534063-291

6-cell, 62-Wh Li-ion battery for use only in Japan 534218-291

6-cell, 55-Wh Li-ion battery 482962-001

4-cell, 37-Wh Li-ion battery 482961-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability. If there is a SIM
inserted in the SIM slot, it should be removed before disassembling the computer. Be sure the SIM is
reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Display inverter

Description Spare part number

Display inverter 487431-001

Before removing the display inverter, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the display inverter:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as it will open.

3. Remove the two rubber screw covers (1) on the bottom edge of the display bezel. The rubber
screw covers are available in the Display Rubber Kit, spare part number 482966-001.

4. Remove the two Phillips PM2.5×6.0 screws (2) that secure the bottom edge of the display bezel to
the display enclosure.

5. Flex the hinge cover areas (1) and the bottom edge (2) of the display bezel until the bezel
disengages from the display enclosure.
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6. Release the bottom edge of the display bezel (3) from the display assembly.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard light cable is attached,
and disconnect the keyboard light cable from the display inverter.

8. Remove the two Phillips PM2.5×4.0 screws (2) that secure the display inverter to the display
enclosure.

9. Release the display inverter (3) from the display enclosure as far as the display panel cable and
backlight cable allow.

10. Disconnect the display panel cable (4) and the backlight cable (5) from the display inverter.

11. Remove the display inverter.

Reverse this procedure to install the display inverter.
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Bluetooth module
NOTE: The Bluetooth® module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 487432-001. See Bluetooth
module cable on page 95 for removal procedures for the Bluetooth module cable.

Description Spare part number

Bluetooth module 483113-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the Bluetooth module:

1. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the Bluetooth module compartment
cover to the computer.

2. Remove the Bluetooth module compartment cover (2) by lifting it straight up.

NOTE: The Bluetooth module compartment cover is included in the Plastics Kit, spare part
number 487429-001.

3. Release the Bluetooth module (1) from the computer as far as the Bluetooth module cable allows.
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4. Disconnect the Bluetooth module cable (2) from the Bluetooth module.

5. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number

320-GB, 7200-rpm 531969-001

250-GB, 7200-rpm 495059-001

160-GB, 7200-rpm 483186-001

120-GB, 7200-rpm 483184-001

128-GB solid-state drive 575554-001

80-GB solid-state drive 486304-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive bay cover to the
computer.
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3. Lift the left side of the hard drive bay cover (2), swing it up and to the right, and remove the
cover. The hard drive bay cover is included in the Plastics Kit, spare part number 487429-001.

4. Loosen the Phillips PM2.5×10.0 captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the right to disconnect it
from the system board.

6. Remove the hard drive (4) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.
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8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive 515874-001

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 483190-001

DVD/CD-RW Combo Drive 483189-001

DVD-ROM Drive 483191-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the optical drive:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.5×9.0 captive screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4. Remove the optical drive (3) from the upgrade bay.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.
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6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.

Upgrade bay device

Description Spare part number

Upgrade bay device cradle 502322-001

Before removing the upgrade bay device, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the upgrade bay device:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.5×9.0 captive screw (1) that secures the upgrade bay device to the
computer.

3. Remove the four Phillips PM2.5×4.0 screws (2) that secure the upgrade bay device to the
computer.

4. Insert a flat-bladed screwdriver or similar tool into the upgrade bay device tab access (3) and
press the tab to the left to release the upgrade bay device from the computer.
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5. Remove the upgrade bay device (4) from the computer.

6. If it is necessary to remove the hard drive from the upgrade bay cradle, position the upgrade bay
cradle with the front bezel toward you.

7. Loosen the Phillips PM2.5×10.0 captive screw (1) that secures the hard drive to the upgrade bay
cradle.

8. Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) forward to disconnect it
from the upgrade bay cradle.

9. Remove the hard drive (4) from the upgrade bay cradle.

Reverse this procedure to install the upgrade bay device.
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Expansion memory module

Description Spare part number

4096-MB memory module (PC2-6400, 800-MHz, DDR2) 598855-001

2048-MB memory module (PC2-6400, 800-MHz, DDR2) 598858-001

1024-MB memory module (PC2-6400, 800-MHz, DDR2) 598861-001

Before removing the expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the memory module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the memory module compartment
cover to the computer.

3. Lift the left side of the cover (2), swing it up and to the right, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 487429-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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5. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the expansion memory module.

WWAN module

Description Spare part number

HP un2400 Mobile Broadband WWAN module 483377-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the WWAN module:

1. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the WWAN module compartment
cover to the computer.
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2. Lift the left side of the cover (2), swing it up and to the right, and remove the cover. The WWAN
module compartment cover is included in the Plastics Kit, spare part 487429-001.

3. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

4. Remove the two Phillips PM2.5×4.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

5. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion into the
WWAN module slot.

Reverse this procedure to install the WWAN module.
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Keyboard
NOTE: All keyboard spare part kits include a keyboard cable, keyboard shield, pointing stick, and
pointing stick cable.

Country or region Spare part number Country or region Spare part number

Belgium 483010-A41 Norway 483010-091

Brazil 483010-201 Portugal 483010-131

The Czech Republic 483010-221 Russia 483010-251

Denmark 483010-081 Saudi Arabia 483010-171

Europe, the Middle East, and
Africa

483010-021 Sweden and Finland 483010-B71

France 483010-051 Slovakia 483010-231

French Canada 483010-121 Slovenia 483010-BA1

Germany 483010-041 South Korea 483010-AD1

Greece 483010-DJ1 Spain 483010-071

Hungary 483010-211 Switzerland 483010-BG1

Iceland 483010-DD1 Taiwan 483010-AB1

Israel 483010-BB1 Thailand 483010-281

Italy 483010-061 Turkey 483010-141

Japan 483010-291 The United Kingdom 483010-031

Latin America 483010-161 The United States 483010-001

The Netherlands 483010-B31   

Pointing stick rubber caps 486565-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the keyboard:

1. Position the computer with front toward you.
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2. Loosen the three Phillips PM2.5×9.0 captive screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Slide the four keyboard retention tabs (1) toward you. The tabs are located between the esc and
f1 keys, between the f4 and f5 keys, between the f8 and f9 keys, and between the f12 and scroll
keys.

6. Lift the rear edge of the keyboard (2), and swing it up and forward until it rests upside down on
the palm rest.

7. Release the ZIF connector (1) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (2) from the system board.
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8. Release the ZIF connector (3) to which the keyboard cable is attached, and disconnect the
keyboard cable (4) from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.

Primary memory module

Description Spare part number

4096-MB memory module (PC2-6400, 800-MHz, DDR2) 598855-001

2048-MB memory module (PC2-6400, 800-MHz, DDR2) 598858-001

1024-MB memory module (PC2-6400, 800-MHz, DDR2) 598861-001

Before removing the primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the keyboard (see Keyboard on page 65).

Remove the primary memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the primary memory module.
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Modem module
NOTE: The modem module spare part kits do not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 487432-001.

Description Spare part number

For use in all countries and regions except Australia and New Zealand 461750-001

Modem module for use only in Australia and New Zealand 461750-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the keyboard (see Keyboard on page 65).

Remove the modem module:

1. Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system
board.

2. Release the modem module (2) from the computer as far as the modem module cable allows.

3. Disconnect the modem module cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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WLAN module

Description Spare part number

Intel Wi-Fi Link 5300 802.11a/b/g/n WLAN module for use in all countries and regions 480986-001

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions 480985-001

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions 482957-001

Broadcom 4322 802.11a/b/g/n WLAN modules:

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

487330-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru,
the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

Broadcom BCM4312 802.11b/g WLAN modules:

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

459263-001
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Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru,
the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

Intel Wi-Fi Link 5100 802.11a/b/g/n 1x2 WLAN module with iAMT 4.0 support for use in
Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada,
the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El
Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and
Vietnam

506678-001

Intel Wi-Fi Link 5300 802.11a/b/g/n 3x3 WLAN module with iAMT 4.0 support for use in
Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada,
the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El
Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and
Vietnam

506679-001

Intel 802.11a/b/g WLAN module for use in Russia, Ukraine, and Pakistan 506680-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the keyboard (see Keyboard on page 65).
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable (2) is
connected to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.5×4.0 screws (3) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

3. Remove the WLAN module (4) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion into the
WLAN module slot.

Reverse this procedure to install the WLAN module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 482963-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the keyboard (see Keyboard on page 65).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Remove the RTC battery (2) from the clip built into the top cover.

Reverse this procedure to install the RTC battery.
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Switch cover

Description Spare part number

Switch cover (includes capacitative board and cable) 486307-001

Capacitative board (includes cable) 487428-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the keyboard (see Keyboard on page 65).

Remove the switch cover:

1. Close the computer and turn it upside down, with the rear panel toward you.

2. Remove the following:

(1) Two rubber screw covers. Screw covers are available in the Rubber Kit, spare part number
482966-001.

(2) Three Torx T8M2.5×7.0 screws.

(3) Two Phillips PM2.0×4.0 broad-head screws.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.
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5. Lift the right side of the keyboard shield (1) until it rests at an angle, and then remove the shield
(2) by lifting it straight up.

NOTE: The keyboard shield is included with the keyboard spare part kit.

6. Release the ZIF connector (1) to which the power button board cable is attached, and disconnect
the power button board cable from the system board.

7. Release the ZIF connector (2) to which the LED board cable is attached, and disconnect the LED
board cable from the system board.

8. Remove the switch cover by lifting it straight up (3).

Reverse this procedure to install the switch cover.
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Power button board

Description Spare part number

Power button board (includes cable) 482964-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the keyboard (see Keyboard on page 65).

6. Remove the switch cover (see Switch cover on page 74).

Remove the power button board:

1. Turn the switch cover upside down, with the front toward you.

2. Remove the Phillips PM2.0×4.0 screw (1) that secures the power button board to the switch cover.

3. Lift the right side of the power button board (2) until it rests at an angle.

4. Remove the power button board (3) by sliding the board to the right at an angle.

Reverse this procedure to install the power button board.
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Fan

Description Spare part number

Fan 487436-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the keyboard (see Keyboard on page 65).

6. Remove the switch cover (see Switch cover on page 74).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the Phillips PM2.5×7.0 screw (2) that secures the fan to the base enclosure.

3. Lift the front edge of the fan (3) until it rests at an angle.

4. Remove the fan (4) by sliding it forward at an angle.

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.
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The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.

Heat sink
NOTE: The heat sink spare part kits include replacement thermal material.

Description Spare part number

For use only with computer models with discrete graphics subsystem memory 483011-001

For use only with computer models with UMA graphics subsystem memory 483012-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following.

a. Keyboard (see Keyboard on page 65)

b. Switch cover (see Switch cover on page 74)

c. Fan (see Fan on page 77)

Remove the heat sink:

NOTE: Steps 1 through 5 apply only to computer models equipped with discrete graphics subsystem
memory. See steps 6 through 8 for removing the heat sink on computer models with UMA graphics
subsystem memory.

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four Phillips PM2.5×11.0
captive screws (1) that secure the heat sink to the system board.
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2. Remove the Phillips PM2.5×4.0 screw (2) that secures the heat sink to the system board.

3. Lift the right side of the heat sink (1) until it rests at angle.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to detach
it.

4. Release the heat sink (2) by sliding it to the right until it clears the left side of the top cover.
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5. Remove the heat sink (3) by sliding it up and forward.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board each time the heat sink is removed. Thermal paste is used on the processor (1)
and the section of the heat sink (1) that services it. Thermal pads are used on the Northbridge
chip (2) and the section of the heat sink (2) that services it, and on the graphics subsystem chip
(3) and the section of the heat sink (3) that services it. Replacement thermal material is included
with all heat sink, system board, and processor spare part kits.

NOTE: Steps 6 through 8 apply only to computer models equipped with UMA graphics
subsystem memory. See steps 1 through 5 for removing the heat sink on computer models with
discrete graphics subsystem memory.
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6. Following the 1, 2, 3, 4, sequence stamped into the heat sink, loosen the four Phillips
PM2.5×11.0 screws (1) that secure the heat sink to the system board.

7. Lift the right side of the heat sink (1) until it rests at an angle.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to detach
it.

8. Release the heat sink (2) by sliding it to the right until it clears the left side of the top cover.
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9. Remove the heat sink (3) by sliding it up and forward.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board each time the heat sink is removed. Thermal paste is used on the processor (1)
and the section of the heat sink (1) that services it. Thermal pads are used on the Northbridge
chip (2) and the section of the heat sink (2) that services it. Replacement thermal material is
included with all heat sink, system board, and processor spare part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include replacement thermal material.

Description Spare part number

Intel Core 2 Duo T9900, 3.06-GHz processor (1066-MHz FSB, 6-MB L2 cache) 570434-001

Intel Core 2 Duo T9800, 2.93-GHz processor (1066-MHz FSB, 6-MB L2 cache) 507951-001

Intel Core 2 Duo T9600, 2.80-GHz processor (1066-MHz FSB, 6-MB L2 cache) 507955-002

Intel Core 2 Duo T9550, 2.66-GHz processor (1066-MHz FSB, 6-MB L2 cache, 35W) 507953-001

Intel Core 2 Duo T9400, 2.53-GHz processor (1066-MHz FSB, 6-MB L2 cache, 35W) 507956-002

Intel Core 2 Duo P9600, 2.66-GHz processor (1066-MHz FSB, 3-MB L2 cache, 25W) 507957-001

Intel Core 2 Duo P9500, 2.53-GHz processor (1066-MHz FSB, 6-MB L2 cache, 25W) 507958-001

Intel Core 2 Duo P8800, 2.66-GHz processor (1066-MHz FSB, 3-MB L2 cache) 570036-001

Intel Core 2 Duo P8700, 2.53-GHz processor (1066-MHz FSB, 3-MB L2 cache) 507960-001

Intel Core 2 Duo P8600, 2.40-GHz processor (1066-MHz FSB, 3-MB L2 cache) 507963-002

Intel Core 2 Duo P8400, 2.26-GHz processor (1066-MHz FSB, 3-MB L2 cache) 507964-002

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Keyboard (see Keyboard on page 65)

b. Switch cover (see Switch cover on page 74)

c. Fan (see Fan on page 77)

d. Heat sink (see Heat sink on page 78)

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.
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2. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor slot.

Reverse this procedure to install the processor.
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Display assembly

Description Spare part number

14.1-inch, WXGA AntiGlare LED display assembly for use on computer models equipped with a
webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two
microphones)

487433-001

14.1-inch, WXGA AntiGlare LED display assembly for use on computer models not equipped
with a webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two
microphones)

483202-001

14.1-inch, WXGA+ AntiGlare display assembly for use on computer models equipped with a
webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two
microphones)

487435-001

14.1-inch, WXGA+ AntiGlare display assembly for use on computer models not equipped with a
webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two
microphones)

483201-001

14.1-inch, WXGA AntiGlare display assembly for use on computer models equipped with a
webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two
microphones)

487434-001

14.1-inch, WXGA AntiGlare display assembly for use on computer models not equipped with a
webcam (includes three WLAN antenna cables, two WWAN antenna cables, and two
microphones)

483200-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 70).

6. Remove the keyboard (see Keyboard on page 65).

7. Remove the switch cover (see Switch cover on page 74).

Remove the display assembly:

1. Close the computer and turn it upside down, with the rear panel toward you.
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2. Remove the following:

(1) Two round rubber screw covers. Screw covers are available in the Rubber Kit, spare part
number 482966-001.

(2) Two wedge-shaped rubber screw covers. Screw covers are available in the Rubber Kit, spare
part number 482966-001.

(3) Four Torx T8M2.5×7.0 screws that secure the display assembly to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Disconnect the display panel cable (1) from the system board.

6. Disconnect the microphone cable (2) from the system board.

7. Remove the wireless antenna cables (3) from the clips and routing channels built into the top
cover.

8. Disconnect the webcam cable (1) from the system board.
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9. Remove the wireless antenna cables (2) from the clips and routing channels built into the top
cover.

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.

10. Remove the two T8M2.5×7.0 screws (1) that secure the display assembly to the computer.

11. Remove the display assembly (2) by lifting it straight up.
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12. If it is necessary to replace the display bezel or display hinges, remove the four rubber screw
covers (1) and the four Phillips PM2.5×7.0 screws (2) that secure the display bezel to the display
assembly. The rubber screw covers are available in the Rubber Kit, spare part number
482966-001.

NOTE: See Display inverter on page 52 for procedures on removing the display inverter.

13. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.

14. Remove the display bezel (3). The display bezel is available using spare part numbers: 

● 488189-001 (for use in computer models equipped with non-LED displays and a webcam)

● 488190-001 (for use in computer models equipped with non-LED displays without a
webcam)

● 518420-001 (for use in computer models equipped with LED displays and a webcam)

● 518421-001 (for use in computer models equipped with LED displays without a webcam)
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15. If it is necessary to replace the display hinges, remove the two Phillips PM2.5×7.0 screws (1) that
secure the display hinges to the display enclosure.

16. Remove the display hinges (2). The left and right display hinges are included in the Display Hinge
Kit, spare part number 482967-001.

The display panel is available using the following spare part numbers:

● 623154-001 (for use in computer models equipped with WXGA displays)

● 623155-001 (for use in computer models equipped with WXGA LED displays)

● 623156-001 (for use in computer models equipped with WXGA+ displays)

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover with fingerprint reader (includes TouchPad buttons) 486303-001

Top cover without fingerprint reader (includes TouchPad buttons) 611810-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Hard drive (see Hard drive on page 56)

b. Keyboard (see Keyboard on page 65)

c. Switch cover (see Switch cover on page 74)

d. Display assembly (see Display assembly on page 85)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the following:

(1) Two round rubber screw covers on the front edge of the base enclosure. Rubber screw covers
are available in the Rubber Kit, spare part number 482968-001.

(2) Two cup-shaped rubber screw covers on the right edge of the base enclosure. Rubber screw
covers are available in the Rubber Kit, spare part number 482968-001.

(3) Seven Torx8 T8M2.5×7.0 screws.

(4) One Phillips PM2.0×5.0 screw.

3. Turn the computer right-side up, with the front toward you.

4. Release the ZIF connector (1) to which the TouchPad cable is attached, and disconnect the
TouchPad cable from the system board.

5. Release the ZIF connector (2) to which the audio/ExpressCard assembly cable is attached, and
disconnect the audio/ExpressCard assembly cable from the system board.

6. Release the ZIF connector (3) to which the fingerprint reader board cable is attached, and
disconnect the fingerprint reader board cable from the system board.

7. Lift the rear edge of the top cover (1) until it detaches from the base enclosure.
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8. Remove the top cover (2) by lifting it straight up.

Reverse this procedure to install the top cover.

TouchPad

Description Spare part number

TouchPad (includes cable and TouchPad button board and cable) 486306-001

Before removing the TouchPad, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Hard drive (see Hard drive on page 56)

b. Keyboard (see Keyboard on page 65)

c. Switch cover (see Switch cover on page 74)

d. Display assembly (see Display assembly on page 85)

e. Top cover (see Top cover on page 90)

Remove the TouchPad:

1. Turn the top cover upside down, with the front toward you.

2. Remove the four Phillips PM2.0×3.0 screws (1) that secure the TouchPad bracket to the top cover.
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3. Release the TouchPad bracket (2) by sliding it toward the back of the top cover.

4. Remove the TouchPad bracket (3) by lifting it straight up.

5. Release the ZIF connector (1) to which the TouchPad button board cable is attached, and
disconnect the TouchPad button board cable from the TouchPad board.

6. Remove the TouchPad board (2) by lifting it straight up.

Reverse this procedure to install the TouchPad.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes cable) 486309-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Hard drive (see Hard drive on page 56)

b. Keyboard (see Keyboard on page 65)

c. Switch cover (see Switch cover on page 74)

d. Display assembly (see Display assembly on page 85)

e. Top cover (see Top cover on page 90)

f. Audio/ExpressCard assembly (see Audio/ExpressCard assembly on page 97)

Remove the fingerprint reader board:

1. Remove the fingerprint reader board cable (1) from the opening in the top cover.

2. Remove the fingerprint reader board (2) by lifting it straight up. The fingerprint reader board is
attached to the top cover using double-sided tape.
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Reverse this procedure to install the fingerprint reader board.

Bluetooth module cable
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 487432-001.

Before removing the Bluetooth module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Hard drive (see Hard drive on page 56)

b. Keyboard (see Keyboard on page 65)

c. Switch cover (see Switch cover on page 74)

d. Display assembly (see Display assembly on page 85)

e. Top cover (see Top cover on page 90)

Remove the Bluetooth module cable:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Detach the Bluetooth module cable (2) from the speaker. The Bluetooth module cable is attached
to the speaker using double-sided tape.

Reverse this procedure to install the Bluetooth module cable.
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Speaker

Description Spare part number

Speaker 486308-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Hard drive (see Hard drive on page 56)

b. Keyboard (see Keyboard on page 65)

c. Switch cover (see Switch cover on page 74)

d. Display assembly (see Display assembly on page 85)

e. Top cover (see Top cover on page 90)

f. Bluetooth module cable (see Bluetooth module cable on page 95)

Remove the speaker:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the Torx8 T8M2.5×7.0 screw (2) that secures the speaker to the base enclosure.
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3. Remove the speaker (3) by lifting it straight up.

Reverse this procedure to install the speaker.

Audio/ExpressCard assembly
NOTE: The Audio/ExpressCard assembly spare part kit does not include an audio cable. The Audio/
ExpressCard assembly cable is included in the Cable Kit, spare part number 487432-001. See Cable
Kit on page 31 for more Cable Kit spare part information.

Description Spare part number

Audio/ExpressCard assembly (includes ExpressCard slot, cable, headphone and microphone
connectors, and SD card reader slot)

482959-001

Before removing the audio/ExpressCard assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Hard drive (see Hard drive on page 56)

b. Keyboard (see Keyboard on page 65)

c. Switch cover (see Switch cover on page 74)

d. Display assembly (see Display assembly on page 85)
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e. Top cover (see Top cover on page 90)

f. Bluetooth module cable (see Bluetooth module cable on page 95)

g. Speaker (see Speaker on page 96)

Remove the audio/ExpressCard assembly:

1. Release the ZIF connector (1) to which the audio/ExpressCard assembly cable is attached, and
disconnect the audio/ExpressCard assembly cable from the system board.

2. Lift the right side of the audio/ExpressCard assembly (2) to disconnect it from the system board.

3. Remove the audio/ExpressCard assembly (3) by sliding it up and to the right.

Reverse this procedure to install the audio/ExpressCard assembly.

Modem module cable
NOTE: The modem module spare part kits do not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 487432-001. The modem module cable
includes an RJ-11 connector.

Before removing the modem module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.
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4. Remove the battery (see Battery on page 50).

5. Remove the following:

a. Hard drive (see Hard drive on page 56)

b. Keyboard (see Keyboard on page 65)

c. Switch cover (see Switch cover on page 74)

d. Display assembly (see Display assembly on page 85)

e. Top cover (see Top cover on page 90)

Remove the modem module cable:

1. Disconnect the modem module cable (1) from the system board.

2. Remove the RJ-11 connector (2) from the clip built into the base enclosure.

Reverse this procedure to install the modem module cable.
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System board
NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

System board for use in all countries and regions except for Russia and the People's Republic of China

For use only with computer models with discrete graphics subsystem memory (includes 256 MB of
graphics subsystem memory

486300-001

For use only with computer models with discrete graphics subsystem memory (includes 128 MB of
graphics subsystem memory

486299-001

For use only with computer models with UMA graphics subsystem memory 486301-001

System board for use in only in Russia and the People's Republic of China

For use only with computer models with discrete graphics subsystem memory (includes 256 MB of
graphics subsystem memory

510352-001

For use only with computer models with discrete graphics subsystem memory (includes 128 MB of
graphics subsystem memory

510351-001

For use only with computer models with UMA graphics subsystem memory 510353-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 54)

b. Hard drive (see Hard drive on page 56)

c. Optical drive (see Optical drive on page 59) or upgrade bay device (see Upgrade bay
device on page 60)

d. Keyboard (see Keyboard on page 65)

e. Switch cover (see Switch cover on page 74)

f. Display assembly (see Display assembly on page 85)

g. Top cover (see Top cover on page 90)

h. Bluetooth module cable (see Bluetooth module cable on page 95)
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i. Speaker (see Speaker on page 96)

j. Audio/ExpressCard assembly (see Audio/ExpressCard assembly on page 97)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Memory module (see Expansion memory module on page 62 and Primary memory module
on page 67)

● WWAN module (see WWAN module on page 63)

● Modem module (see Modem module on page 69)

● WLAN module (see WLAN module on page 70)

● RTC battery (see RTC battery on page 73)

● Fan (see Fan on page 77)

● Heat sink (see Heat sink on page 78)

● Processor (see Processor on page 83)

Remove the system board:

1. Disconnect the modem module cable (1) from the system board.

2. Remove the three Phillips PM2.5×4.0 screws (2) that secure the system board to the base
enclosure.

NOTE: Computer models equipped with UMA graphics subsystem memory will have a fourth
Phillips PM2.5×4.0 screw (3) securing the system board to the base enclosure.

3. Use the optical drive connector (1) to lift the right edge of the system board (2) until it rests at an
angle.
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4. Remove the system board (3) from the base enclosure by sliding it up and to the right at an angle.

Reverse the preceding procedure to install the system board.
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5 Computer Setup

This user guide describes features that are common to most models. Some features may not be
available on your computer.

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

● To select a menu or a menu item, use the keyboard arrow keys and then press enter, or use a
pointing device to click the item.

● To scroll up and down, click the plus sign (+) or the minus sign (-) in the upper-right corner of
the screen.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click Exit in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

● To save your changes and exit Computer Setup menus, click Save in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click Save in the lower-left corner of the screen, and then follow
the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.
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Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the batteries in the system.

● View specification information for the processor, cache and memory size, system
ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory settings.
(Password settings and security settings are not changed when you restore the factory
settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the computer.

Save changes and exit Save changes and exit Save any changes entered during the current session. Then exit and
restart the computer. Your changes go into effect when the computer restarts.

Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator
Password

Set up a BIOS administrator password.

User Management (requires a
BIOS administrator password)

● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS
administrator password)

Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey
Enrollment

Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (if
Present)

Enable/disable the fingerprint reader (select models only; disabled by default).

Allow reset of HP ProtectTools
security keys

Enable/disable reset of HP ProtectTools security keys.
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Select To do this

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security questions and answers used if you
forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive (enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup by turning
on (not restarting) the computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is destroyed
permanently.

System IDs Enter a user-defined computer asset tracking number and ownership tag.

Always Prompt for HP SpareKey
Enrollment

Enable/disable a prompt for HP SpareKey enrollment.

Diagnostics menu

Select To do this

System Diagnostics menu ● F1 System Information—Displays the following information:

◦ Identification information for the computer and the batteries in the system.

◦ Specification information for the processor, cache and memory size, system
ROM, video revision, and keyboard controller version.

● F2 Start-up Test—Verifies the system components needed for starting the computer.

● F3 Run-In Test—Runs a comprehensive check on system memory.

● F4 Hard Disk Test—Runs a comprehensive self-test on any hard drive in the system.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (disabled by default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable diskette boot (enabled by default).

● Enable/disable boot from Extensible Firmware Interface (EFI) File (select models only;
enabled by default).

● Enable/disable internal network adapter boot and set the Preboot eXecution
Environment (PXE) (enabled by default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default). When enabled, USB legacy
support allows the following:

◦ Use of a USB keyboard in Computer Setup even when a Windows® operating
system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette drive, or
optical drive connected by a USB port to the computer.

● Select a parallel port mode: ECP (Enhanced Capabilities Port), standard, bidirectional,
or EPP (Enhanced Parallel Port).

● Enable/disable BIOS DMA data transfers (select models only; enabled by default).

● Enable/disable fan always on while connected to an AC outlet (disabled by default).

● Enable/disable LAN Power Save. When enabled, saves power by turning off the LAN
when not in use (enabled by default).

● Enable/disable Data Execution Prevention. When enabled, the processor can disable
some virus code execution, which helps to improve computer security.

● SATA (Serial Advanced Technology Attachment) device mode. The following options
are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (Redundant Array of Independent Disks)
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Select To do this

NOTE: Availability of the options above varies by computer model.

● Enable/disable secondary battery fast charge (enabled by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Virtualization Technology (select models only; enabled by default).

● Enable/disable TXT (Intel® Trusted Execution Technology) (select models only;
enabled by default).

● Enable/disable Dual Core CPU (select models only; enabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by default).

● Enable/disable embedded WWAN device radio (select models only; enabled by
default).

● Enable/disable embedded Bluetooth® device radio (enabled by default).

● Enable/disable the Network Interface Controller (LAN) (enabled by default).

● Set the wake on LAN state. Options include the following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the fingerprint device (enabled by default).

● Enable/disable a modem device (enabled by default).

Port Options (all are enabled by
default)

NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and ExpressCard
devices on the advanced port replicator.

● Enable/disable the 1394 port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 24.30 cm 9.57 in

Width 33.10 cm 13.03 in

Height (front to rear) 3.13 to 3.41 cm 1.23 to 1.34 in

Weight (computer equipped with an optical drive, WXGA display
assembly, 1 memory module, WLAN module, and 6-cell battery)

2.40 kg 5.29 lbs

Weight (computer equipped with the optical drive weight saver,
WXGA display assembly, 1 memory module, WLAN module, and 4-
cell battery)

2.10 kg 4.63 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine
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 Metric U.S.

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min
sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min
sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

14.1-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 27.94 cm 11.0 in

Width 20.83 cm 8.2 in

Diagonal 35.56 cm 14.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40 horizontal, +20/–40° vertical (typical)
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Hard drive specifications
 250-GB* 160-GB* 120-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 625,141,400 488,376,280 312,560,640 234,420,480

Disc rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW Double-Layer Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R,
CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R,
CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

DVD/CD-RW Combo Drive specifications 113



DVD-ROM Drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,

CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R,
CD-RW, Photo CD (single and multisession), CD-Bridge

Access time CD DVD

Random < 100 ms < 125 ms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused
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I/O address (hex) System function (shipping configuration)

201 JoyStick (decoded in ESS1688)

202 - 21F Unused

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 ExpressCard controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in the
computer. All screws listed in this section are available in the Screw Kit, spare part number
486305-001.
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 5 5.0 mm 2.0 mm 5.0 mm

Where used:

(1) One captive screw that secures the Bluetooth module compartment cover to the computer (screw is
secured with a C-clip)

(2) Two captive screws that secure the hard drive bay cover to the computer (screws are secured with
C-clips)

(3) One captive screw that secures the memory module compartment cover to the computer (screw is
secured with a C-clip)

(4) One captive screw that secures the WLAN module compartment cover to the computer (screw is
secured with a C-clip)
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Phillips PM2.5×11.0 captive screw

Color Quantity Length Thread Head diameter

Black 2 11.0 mm 2.5 mm 5.0 mm

Where used: One captive screw that secures the hard drive to the computer (screw is secured by a
C-clip)

Where used: One captive screw that secures the hard drive to the upgrade bay cradle (screw is
secured by a C-clip)
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Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips 2.5×9.0 captive screw

Color Quantity Length Thread Head diameter

Black 4 9.0 mm 2.5 mm 5.0 mm

Where used:

(1) One captive screw that secures the optical drive or upgrade bay device to the computer (screw is
secured by a C-clip)

(2) Three captive screws that secure the keyboard to the computer (screws are secured by C-clips)
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 2 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 5 4.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the upgrade bay device to the computer

Where used: One screw that secures the heat sink to the system board on computer models equipped
with discrete graphics subsystem memory
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Silver 19 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WWAN module to the system board

Where used:

(1) Two screws that secure the modem module to the system board
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(2) Two screws that secure the WLAN module to the system board

Where used: One screw that secures the power button board to the switch cover

Where used: 2 screws that secure the display inverter to the display enclosure

Where used: 4 screws that secure the TouchPad bracket to the top cover
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Where used: 2 screws that secure the audio/ExpressCard assembly to the top cover

Where used:

(1) Three screws that secure the system board to the base enclosure on all computer models

(2) One screw that secures the system board to the base enclosure on computer models equipped with
UMA graphics subsystem memory

Phillips PM2.0×3.0 broad-head screw
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Color Quantity Length Thread Head diameter

Black 2 3.0 mm 2.0 mm 6.0 mm

Where used: 2 screws that secure the switch cover to the computer
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Torx8 T8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 17 7.0 mm 2.5 mm 5.0 mm

Where used: 3 screws that secure the switch cover to the computer

Where used: 4 screws that secure the display assembly to the computer
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Where used: 2 screws that secure the display assembly to the computer

Where used: 7 screws that secure the top cover to the base enclosure

Where used: One screw that secures the speaker to the base enclosure
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Phillips PM2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 7 7.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the fan to the base enclosure

Where used: 4 screws that secure the display bezel to the display enclosure

Phillips PM2.5×7.0 screw 133



Where used: 2 screws that secure the hinges to the display enclosure
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Phillips PM2.5×11.0 captive screw

Color Quantity Length Thread Head diameter

Silver 4 11.0 mm 2.5 mm 5.0 mm

Where used: 4 captive screws that secure the heat sink to the system board (screws are secured by
C-clips)
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Phillips PM2.0×5.0 screw

Color Quantity Length Thread Head diameter

Black 1 5.0 mm 2.0 mm 5.0 mm

Where used: One screw that secures the top cover to the base enclosure
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8 Backup and recovery in Windows
Vista

This chapter describes features that are common to most models. Some features may not be available
on your computer.

Overview
To protect your information, the computer provides tools to back up individual files and folders or your
entire hard drive. In case of system instability or failure, you can use the backup files to restore the
contents of your computer.

When creating backups, HP recommends the following sequence:

1. Create a set of recovery discs of the entire hard drive as soon as possible after you set up your
computer.

2. Schedule periodic backups to record changes made to your computer.

In addition to manual backup-and-recovery tools, you can use Windows® System Recovery to
automatically back up and restore your information. This feature automatically backs up changes made
to your computer daily and also at important milestones, such as when you add a program or driver.
Use this tool to restore the computer to a previous state without losing personal files or e-mails. You can
also manually set restore points and change restore settings.
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Creating recovery discs
After setting up the computer, create a set of recovery discs for the initial backup of the entire hard
drive.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system failure.

Note the following tips for creating recovery discs:

● Connect the computer to AC power during the process.

● Use any of the following types of discs (purchased separately): CD-R, CD-RW, DVD+R, DVD+R DL,
DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type of optical drive
installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs and will
reduce the number of recovery discs required.

● Number each disc before inserting it into the optical drive of the computer.

To create a set of recovery discs:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Click Back up computer.

3. Follow the on-screen instructions.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.
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Backing up your information
After you create the recovery discs for the initial backup of the entire hard drive, you should schedule
automatic backups of your files. You should also back up your files before you modify the hardware or
software.

Several types of backup are available in the Backup and Restore Center:

● Individual files or folders

● Restore points

● Entire hard drive

Backup tips
● Connect the computer to AC power during the backup process.

● Store personal files in the Documents folder and back them up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.
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Backing up individual files or folders
When you perform a backup of the entire hard drive, you are saving the full factory image, including
the Windows operating system, software programs, all personal files and folders, and configuration
settings.

You can back up a copy of the entire hard drive to either of the following locations:

● Optional external hard drive

● Optical discs (CDs or DVDs)

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your hard drive:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Click Back up computer. You will be prompted to select a destination for the backup files.

3. Follow the on-screen instructions.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Scheduling an automatic backup
You can schedule automatic backups for the entire system, for recovery points, or for specific files and
folders. Backups can be scheduled at specific intervals (daily, weekly, or monthly).

To schedule an automatic backup:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Click Change settings.

The Backup Status and Configuration Window opens.

3. Click Change backup settings. You will be prompted to select a destination for the backup
files.

4. Follow the on-screen instructions.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.
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Creating system restore points
In addition to the manual backup-and-recovery tools, you can use Windows System Recovery to
automatically back up and restore your information. This feature automatically creates restore points
just before a significant change is made to your system, such as the installation of a program or driver.
You can also set manual restore points.

NOTE: The first system restore point is a snapshot of the entire image that is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create manual restore points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier restore point does not delete data files or e-mails created since that
restore point. To create a system restore point:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. On the left side of the screen, click Create a restore point or change settings.

3. Click Create. You will be prompted to name this restore point.

4. Follow the on-screen instructions.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery
In case of hard drive failure or system instability, the computer provides tools to recover your files.

You can recover your information using the following methods:

NOTE: Have your backup files available. Some of these methods will prompt you for your backup
files stored on recovery discs or on a drive.

● Recovering individual files that you have previously backed up using Backup and Restore Center

● Restoring the computer to a previous state by using system restore points

● Recovering individual files that you have previously backed up or the entire hard drive using f8
recovery tools:

NOTE: You can use these methods only if the Windows recovery partition has not been deleted.

◦ Windows Recovery Environment (WinRE)

◦ Recovery Manager

● Recovering the entire hard drive using f11

NOTE: You can use this method only if the Windows recovery partition has not been deleted.

● Recovering information using an operating system DVD (purchased separately)

Recovering individual files
To recover individual files using the Backup and Restore Center, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Maintenance > Backup and Restore Center.

3. Click Restore files. You will be prompted to select the location of the backup files.

4. Follow the on-screen instructions.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Restoring the computer to a previous state
Your computer automatically creates restore points daily (depending on your computer activity) and
when you make a major change to the computer, such as adding software or a new driver. If you
decide to reverse changes made to the computer, you can revert back to a previous restore point.

NOTE: If you don't like the state of your computer after you restore it, you can also undo the
restoration.

To access a restore point:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Click Restore my computer to an earlier time. A calendar is displayed to help you find
dates associated with your restore points.

3. Select the restore point to revert to.

NOTE: If you do not use your computer every day, some days may not have restore points.

Recovering information using f8 recovery tools
You can recover individual files or the entire hard drive using the recovery discs that you previously
created or an optional external hard drive where you have backed up your information.

The following tools will help you recover your information:

● Windows Recovery Environment (WinRE)

● Recovery Manager

NOTE: You can use these recovery methods only if the Windows recovery partition has not
been deleted.
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Recovering information using Windows Recovery Environment (WinRE)

Windows Recovery Environment (WinRE) can perform a recovery from either an optional external hard
drive where you have backed up your information or from recovery discs that you previously created.

CAUTION: Using Windows Recovery Environment (WinRE) will completely erase hard drive contents
and reformat the hard drive. All files you have created and any software installed on the computer will
be permanently removed. When reformatting is complete, the recovery process will restore the
operating system, as well as the drivers, software, and utilities from the backup used for recovery.

To initiate recovery using WinRE, follow these steps:

NOTE: This process will take several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then press f8 before the Windows operating system loads.

3. Select Repair your computer.

NOTE: The “Repair your computer” option is displayed only if the Windows recovery partition
has not been deleted. If the option is not displayed, refer to the “Recovering information using a
Windows Vista operating system DVD (purchased separately)” section.

4. Follow the on-screen instructions.

5. Click Next.

6. Select your user name, type your password (if applicable), and then click OK.

7. If you are using recovery discs, insert the last disc of the recovery disc backup set.

NOTE: Inserting the last disc of the backup set confirms the presence of a valid backup. If you
insert any other disc, the backup will not be recognized.

– or –

If you are using an optional external hard drive, connect it to the computer.

8. Click Windows Complete PC Restore.

9. Follow the on-screen instructions.
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Recovering information using Recovery Manager

If other methods do not work, you can recover your hard drive (in its factory state) as a last resort:

CAUTION: Using Recovery Manager will completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer will be permanently
removed. Recovery Manager reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

1. If possible, back up all personal files.

2. Restart the computer, and then press f8 before the Windows operating system loads.

3. Select Repair your computer.

NOTE: The “Repair your computer” option is displayed only if the Windows recovery partition
has not been deleted. If the option is not displayed, refer to the “Recovering information using a
Windows Vista operating system DVD (purchased separately)” section.

4. Follow the on-screen instructions.

5. Click Next.

6. Select your user name, type your password (if applicable), and then click OK.

7. Click HP Recovery Manager.

8. Follow the on-screen instructions.

Recovering the entire hard drive using f11
You can recover the entire hard drive (in its factory state) from the Windows recovery partition using
f11.

CAUTION: Using f11 will completely erase hard drive contents and reformat the hard drive. All files
you have created and any software installed on the computer will be permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

NOTE: You can use this recovery method only if the Windows recovery partition has not been
deleted. To recover the hard drive from the recovery partition, follow these steps:

1. If possible, back up all personal files.

2. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

3. Press f11 while the “Press for recovery” message is displayed on the screen.

4. Follow the on-screen instructions.
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Recovering information using a Windows Vista operating system
DVD (purchased separately)

You can purchase a Windows Vista® operating system DVD to reboot the computer and repair the
operating system. During the restore process, you will be prompted for your entire drive backup files.
Make sure that your most recent backup of the hard drive (stored on recovery discs or on an external
drive) is easily accessible. To order a Windows Vista operating system DVD, go to
http://www.hp.com/ support, select your country or region, and follow the on-screen instructions. You
can also order the DVD by calling technical support. For contact information, refer to the Worldwide
Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD will completely erase hard drive contents
and reformat the hard drive. All files you have created and any software installed on the computer will
be permanently removed. When reformatting is complete, the recovery process will help you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process will take several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

8. Remove the Windows Vista operating system DVD.

9. If you are using recovery discs, insert the last disc of the recovery disc backup set.

NOTE: Inserting the last disc of the backup set confirms the presence of a valid backup. If you
insert any other disc, the backup will not be recognized.

– or –

If you are using an optional external hard drive, connect it to the computer.

10. Click Windows Complete PC Restore.

11. Follow the on-screen instructions.
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9 Backup and recovery in Windows
XP

This chapter describes features that are common to most models. Some features may not be available
on your computer.

Backing up your information
NOTE: You can recover only the files that you have previously backed up. HP recommends that you
use the Windows backup utility to create a hard drive backup as soon as you set up your computer.

With the Windows backup utility, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesirable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

NOTE: The Windows backup utility backs up only data files. The operating system, drivers, and
programs are located on the operating system disc and System Recovery disc that are included with the
computer.

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software
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Backup suggestions
● Connect the computer to external power before performing backup and recovery procedures.

● Create system recovery points.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

4. Save the document.

Backing up individual files or folders
You can back up individual files or folders to an optional external hard drive or to a network drive.

NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

To back up individual files or folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Follow the on-screen instructions.
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Backing up all files and folders
When you back up all files and folders, you are saving all personal files and folders, all system files,
and configuration settings at one time.

NOTE: When you back up all files and folders, this does not include the operating system or
programs.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

NOTE: A copy of the backup files can be stored on an optional external hard drive or on a network
drive.

To back up all files and folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Click All information on this computer, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points
When you back up system modifications since your last backup, you are creating system recovery
points. This allows you to save a snapshot of your hard drive at a specific point in time. You can then
recover back to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > Accessories > System Tools > System Restore.

The System Restore window opens.

2. Click Create a new restore point, and then click Next.

3. Type a short description of the restore point. This will be used as the name of the restore point.
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4. Click Create.

5. Follow the on-screen instructions.
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Scheduling backups
You can schedule backups for the entire system, for recovery points, or for specific files and folders.
Backups can be scheduled at specific intervals (daily, weekly, or monthly) or at specific events, such as
at system restart or when you log on.

To schedule backups:

1. Select Start > All Programs > Accessories > System Tools > Schedule Tasks.

The Schedule Tasks window opens.

2. Double-click Add Scheduled Task, and then click Next.

3. Select Backup in the Application list, and then click Next.

4. Type a name for the backup, select when you want the backup to be performed, and then click
Next.

5. Enter your user name, password, and password again to confirm. Click Next, and then click
Finish.

Performing a recovery
The Windows backup utility helps you recover important files that you have previously backed up in
case of system failure.

NOTE: To recover the operating system and programs, use the operating system disc and System
Restore disc that are included with the computer.

Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

3. Click Restore files and settings, and the click Next.

4. Follow the on-screen instructions.
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10 Connector pin assignments

1394

Pin Assignment

1 Power

2 Ground

3 TPB-

4 TPB+

5 TPA-

6 TPA+
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Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone) 153



External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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11 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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12 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the display inverter
(2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port

location 18
pin assignments 152

A
AC adapter, spare part numbers

33
accessory battery connector 19
AHCI (Advanced Host Controller

Interface) 107
ambient light sensor 9
antenna

components 10
disconnecting 64, 72
locations 10
spare part number 23, 36

audio card cable, spare part
number 31

audio, product description 4
audio-in jack

location 18
pin assignments 153

audio-out jack
location 18
pin assignments 153

audio/ExpressCard assembly
removal 97
spare part number 28, 35, 97

B
backing up 140
backup

changes to your system 137
files and folders 140, 148
hard drive 140, 147
modifications made to the

system 149
scheduling 140, 151

base enclosure, spare part
number 28, 36

battery
removal 50
spare part numbers 28, 36,

50
battery (travel), spare part

number 34, 35
battery bay 19
battery light 13, 16
battery release latch 20
BIOS Administrator Password

105
Bluetooth compartment 16
Bluetooth module

removal 54
spare part number 29, 38, 54

Bluetooth module cable
illustrated 31
removal 95

Bluetooth module compartment
cover

illustrated 30
removal 54

boot options 107
boot order 107
bottom components 19
built-in device

Bluetooth device radio 108
fingerprint reader 108
modem 108
Network Interface Controller

(LAN) 108
Wake on LAN 108
wireless button 108
WWAN device radio 108

built-in device options 108
button

info 11

power 11
presentation 11
volume mute 11
wireless 11

button components 11
buttons

display release 16
keyboard light 9

C
Cable Kit

contents 31
spare part number 25, 31, 39

cables, service considerations 43
capacitative board, spare part

number 39
caps lock light 14
chipset, product description 1
CMOS clearing 47
components

antenna 10
bottom 19
buttons 11
display 9
fingerprint reader 11
front 16
keys 12
left-side 18
lights 13
pointing device 14
rear 17
right-side 17
switches 11
top 9
wireless antenna 10

computer feet
locations 49
spare part number 49
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Computer Setup
accessing 103
Diagnostics menu 106
File menu 105
navigating and selecting 103
restoring factory settings 104
Security menu 105
System Configuration menu

107
using 103

computer specifications 109
connectors

accessory battery 19
docking 19
service considerations 43

creating recovery points 149

D
device configurations 107
Diagnostics menu 106
Disk Sanitizer 106
diskette drive, precautions 43
display assembly

removal 85
spare part numbers 23, 38,

39, 85
display bezel

removal 88
spare part numbers 23, 39,

88
Display Cable Kit, spare part

number 23, 36
display component recycling 159
display components 9
display hinge

removal 89
spare part number 89

Display Hinge Kit, spare part
number 23, 36, 89

display inverter
removal 52
spare part number 23, 39, 52

display release button 16
display specifications 110
docking connector 19
drive light 13, 16
DriveLock password 106
DriveLock, automatic 106

drives
boot order 107
preventing damage 43

Dual Core CPU 108
DVD-ROM Drive

precautions 43
removal 59
spare part number 28, 32,

38, 59
specifications 114

DVD/CD-RW Combo Drive
precautions 43
removal 59
spare part number 28, 32,

38, 59
specifications 113

DVD±RW and CD-RW Combo
Drive

precautions 43
removal 59
spare part number 28, 32,

38, 59
specifications 112

E
electrostatic discharge 44
esc key 12
Ethernet, product description 5
Execution Disable 107
ExpressCard slot 18
ExpressCard slot bezel, illustrated

30
external media cards, product

description 5
external monitor port

location 17
pin assignments 154

F
f11 recovery 145
f8 recovery tools

Recovery Manager 145
Windows Recovery Environment

(WinRE) 144
factory state, recovering to 145
fan

removal 77
spare part number 24, 39, 77

feet
locations 49
spare part number 49

fingerprint reader 12
fingerprint reader board

removal 94
spare part number 27, 38, 94

fn key 12
front components 16
function keys 12

G
graphics, product description 2
grounding equipment and

methods 46

H
hard disk test 106
hard drive

precautions 43
product description 3
removal 56
spare part numbers 28, 32,

56
specifications 111

hard drive backup 140, 147
hard drive bay 19
hard drive bay cover

illustrated 30
removal 57

hard drive bracket, removal 58
hard drive recovery 138, 151
headphone jack

location 18
pin assignments 153

heat sink
removal 78
spare part numbers 24, 37,

78
hinge

removal 89
spare part number 23, 36, 89

HP QuickLook 108
HP SpareKey Enrollment 106

I
I/O address specifications 117
IDE (Integrated Drive Electronics)

107
info button 11
internal display switch 11
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interrupt specifications 116

J
jacks

audio-in 18
audio-out 18
headphone 18
microphone 18
modem 17
network 17
RJ-11 17
RJ-45 17

K
key components 12
keyboard

product description 6
removal 65
spare part numbers 23, 36,

65
keyboard light 9
keyboard light button 9
keyboard shield

removal 75
keypad keys 12
keys

esc 12
fn 12
function 12
keypad 12
Windows applications 12
Windows logo 12

L
LAN Power Save 107
language, changing in Computer

Setup 107
left-side components 18
legacy support, USB 103, 107
light components 13
lights

battery 13, 16
caps lock 14
drive 13, 16
keyboard 9
num lock 14
power 13, 16
volume down 14
volume mute 14
volume up 14

webcam 9
wireless 13, 16

Logo Kit, spare part number 23,
40

M
manual restore points 141
mass storage devices, spare part

numbers 32
memory map specifications 119
memory module

product description 2
removal 62, 67
spare part numbers 25, 29,

41, 62, 67
memory module compartment 19
memory module compartment cover

illustrated 30
removal 62

microphone 9
microphone jack

location 18
pin assignments 153

model name 1
modem jack

location 17
pin assignments 155

modem module
product description 4
removal 69
spare part numbers 25, 35,

69
modem module cable

illustrated 31
removal 98

monitor port
location 17
pin assignments 154

N
network jack

location 17
pin assignments 155

num lock light 14

O
operating system, product

description 7
optical drive

precautions 43
product description 4

removal 59
spare part numbers 28, 32,

59
specifications 112, 113, 114

P
packing guidelines 45
panels, product description 2
parallel port mode 107
password clearing 47
passwords 105
pin assignments

1394 port 152
audio-in jack 153
audio-out jack 153
external monitor port 154
headphone jack 153
microphone jack 153
modem jack 155
monitor port 154
network jack 155
RJ-11 155
RJ-45 jack 155
Universal Serial Bus (USB)

port 156
plastic parts 42
Plastics Kit

contents 30
spare part number 25, 30, 39

pointing device components 14
pointing devices, product

description 6
pointing stick 14
pointing stick button 14
pointing stick rubber caps, spare

part number 24, 38, 65
port options

1394 port 108
flash media reader 108
parallel port 108
serial port 108
USB port 108

ports
1394 18
external monitor 17
monitor 17
product description 5
USB 17, 18

power button 11
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power button board
removal 76
spare part number 23, 36, 76

power connector 17
power cord

set requirements 157
spare part numbers 33, 39

power light 13, 16
power requirements, product

description 6
presentation button 11
processor

product description 1
removal 83
spare part numbers 25, 40,

83
product description

audio 4
chipset 1
Ethernet 5
external media cards 5
graphics 2
hard drives 3
keyboard 6
memory module 2
modem module 4
operating system 7
optical drives 4
panels 2
pointing devices 6
ports 5
power requirements 6
processors 1
product name 1
security 7
serviceability 8
upgrade bay 4
video 4
wireless 5

product name 1

R
RAID (Redundant Array of

Independent Disks) 107
rear components 17
recovering to factory state 145
recovery discs, creating 138
Recovery Manager 145

recovery methods
Backup and Restore Center

138
Recovery Manager 145
Windows Recovery Environment

(WinRE) 144
Windows Vista operating

system DVD 146
recovery partition 142
recovery points 149
removal/replacement

preliminaries 42
procedures 48

restore points 143
restore security defaults 108
restoring the factory settings 104
right-side components 17
RJ-11 jack

location 17
pin assignments 155

RJ-45 jack
location 17
pin assignments 155

RTC battery
removal 73
spare part number 27, 36, 73

Rubber Kit, spare part number
28, 36

run-in test 106

S
scheduling backups 151
Screw Kit

contents 120
spare part number 34, 38

screw listing 120
SD card reader 16
Secondary Battery Fast Charge

108
security cable slot 17
Security menu

Automatic DriveLock 106
change password 106
Disk Sanitizer 106
DriveLock 106
fingerprint reader reset 105
HP SpareKey 105
password policy 105
System IDs 106
user management 105

security, product description 7
serial number 21
service considerations 42
service tag 48
serviceability, product description

8
set security level 108
SIM slot 20
SIM, removal 51
smart card reader 17
solid-state drive, spare part

number 29, 32, 38, 41, 56
speaker

removal 96
spare part number 28, 38, 96

speakers 16
specifications

computer 109
display 110
DVD-ROM Drive 114
DVD/CD-RW Combo Drive

113
DVD±RW and CD-RW Combo

Drive 112
hard drive 111
I/O addresses 117
interrupts 116
memory map 119
optical drive 112, 113, 114
system DMA 115

start-up test 106
static-shielding materials 46
switch components 11
switch cover

removal 74
spare part number 23, 38, 74

system backup 137, 147
system board

removal 100
spare part numbers 28, 38,

100
System Configuration menu 107
System Diagnostics menu 106
system DMA 115
system fan 107
system IDs 106
system information 105
system memory map 119
system points 143
system recovery points 149
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T
thermal material, replacement 80,

82
tools required 42
top components 9
top cover

removal 90
spare part number 27, 38,

41, 90
TouchPad

location 14
spare part number 27, 38

TouchPad board
removal 92
spare part number 92

TouchPad bracket, removal 93
TouchPad button 14, 15
TouchPad button board

removal 92
spare part number 92

TouchPad scroll zone 14
transporting guidelines 45
travel battery, spare part number

34, 35
TXT (Intel Trusted Execution

Technology) 108

U
unknown password 47
upgrade bay 17
upgrade bay device

removal 60
spare part number 60

upgrade bay device cradle
spare part number 28, 32,

40, 41
upgrade bay, product

description 4
USB legacy support 103, 107
USB port

location 17, 18
pin assignments 156

using automatic restore points
141

V
vents 18, 19
video, product description 4
Virtualization Technology 108
volume down light 14

volume mute button 11
volume mute light 14
volume scroll zone 12
volume up light 14

W
webcam

location 9
spare part number 23, 38

webcam light 9
Windows applications key 12
Windows logo key 12
Windows Recovery Environment

(WinRE) 144
Windows Vista operating system

DVD 146
wireless antenna

components 10
disconnecting 64, 72
locations 10
spare part number 23, 36

Wireless Antenna Kit, spare part
number 23, 36

wireless button 11
wireless light 13, 16
wireless, product description 5
WLAN module

removal 70
spare part numbers 25, 35,

38, 70
workstation guidelines 45
WWAN module

removal 63
spare part number 29, 38, 63

WWAN module compartment 19
WWAN module compartment

cover
illustrated 30
removal 63
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